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MODEL: DVR4ENTPACK2 

Professional Surveillance Pack 
Digital Video Recorder with 4 Security Cameras 

‘USER MANUAL’ 
 
 
 

 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
DVR       2 x Cameras – 30m night-vision range 
-  Advanced MPEG4 Video Compression Technology -  High Quality CCD Image sensor 

-  Multiplex Operation     -  24 x IR LED’s 

-  Long Recording Duration                           -  420 TVL Resolution, 520 x 582 Pixels  

-  Intelligent Video Motion Detection Recording  2 x Cameras – 15m night-vision range 

-  Remote Network Surveillance & Backup Functions -  High Quality CCD Image sensor 

-  Easy to operate like a VCR     -  12 x IR LED’s 

-  System Auto recovery after power loss (blackout)          -  420 TVL Resolution, 520 x 582 Pixels 
 
 
 
 

Note: The latest version of this manual can be found at: 
http://www.watchguardalarms.com.au 

 

N517 

www.watchguardalarms.com.au
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Safety Warning 
 
 
 
 

CAUTION       
 
To reduce the risk of electric shock, do not expose this machine to rain or moisture.  
Only operate this machine from the type of power source indicated on the label. 
RhinoCo Technology shall not be liable for any damages arising out of any improper use, even if we have been advised 
of the possibility of such damages. 
 
The lightning flash with arrowhead symbol, within an equilateral triangle, is intended to alert the user to the presence of 
uninsulated “dangerous voltage” within the product’s enclosure that may be of sufficient magnitude to constitute a risk of 
electric shock to persons. 
 
This exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating 
and maintenance (servicing) instructions in the literature accompanying the appliance. 
 

C-Tick & CE Mark  
 
This apparatus is manufactured to comply with the radio interference requirements. 
 
RhinoCo Technology does not warrant that this manual will be uninterrupted or error-free. We reserve the right to revise 
or remove any content in this manual at any time. 
 
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE PERSONAL 
AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE WITH THE MPEG-4 
VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A 
CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A 
VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO. NO LICENSE IS GRANTED OR SHALL 
BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL 
INTERNAL AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. 
 

About This Manual 
 
This user manual covers the menu system and network functionality of your digital video recorder (DVR). Please refer to 
the included Quick Installation Guide for information on: 
 

• Package contents. 
• Unpacking and connecting your DVR system. 
• Setting the date and time. 
• Starting and stopping recording. 
• Searching and playing back recorded footage. 
• Using the Keylock feature. 
• Troubleshooting 
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Menu System 

Navigating the Menu 
The following buttons are used to navigate through the menu. 
 

 
 

 

UP=▲, 

DOWN=▼, 

LEFT=◄, RIGHT=► 

Press “MENU” button to enter the 
(OSD) On Screen Display menu list 

The default admin password is 0000.  
Enter the default password by pressing 
“ENTER” 4 times 

(MENU) 
RECORD 

TIMER 
DDAATTEE  

ADVANCE 
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Menu Tree 
The menu system for the DVR can be reached by pressing the MENU button. The menu system has the following 
structure. 
 

 
 

DDAATTEE::  
YYEEAARR MMOONNTTHH

FFOORRMMAATT:: YY--MM--

TTIIMMEE::  
HHOOUURR MMIINN SSEECC

MMEENN

RREECCOO TTIIMMEE DDAATT AADDVVAANNCC

TTIITTLLEE  

BBRRIIGG  

CCOONNTT  

SSAATTUU  

HHUUEE  

CCOOVV  

RREECC  

CCAAMMEERR

DDIISSPPLL

RREEMMOO

NNEETTWWOO

MMAANNUUAALL  
RREECCOORRDD

EEVVEENNTT  
RREECCOORRDD

TTIIMMEERR  
RREECCOORRDD

OOVVEERRWWRRIITTEE  

RREECCOORRDD  IIMMGG  

RREECCOORRDD  

MMAANNUUAALL  
RREECCOORRDD IIPPSS

EEVVEENNTT  
RREECCOORRDD IIPPSS

TTIIMMEERR  
RREECCOORRDD

TTOOTTAALL  IIPPSS  

DDAATTEE  

SSTTAARRTT  
HHHH :: MMMM

EENNDD  
HHHH :: MMMM

AALLEE

EEVVEENNTT

HHDDDD

TTIITTLLEE  

DDAATTEE  

HHDDDD  

LLOOSSSS  

PPLLAAYYBBAACC
KK IINNFFOO

DDWWEELLLL  
DDUURRAATTIIOONN  

((SSEECC))

DDEE--  
IINNTTEERRLLAACC

EEXXTT..

IINNTT..

KKEEYY

VVLLOOSSSS

MMOOTTIIOONN

AALLAARRMM

AALLAARRMM 
DDUURRAATTIIOONN

HHDDDD BBUUZZZZEERR

HHDDDD NNEEAARRLLYY 
FFUULLLL ((GGBB))

SSYYSSTTEE

SSEERRIIAALL

BBAAUUDD

HHOOSSTT

IIRR

PPAASSSSWWOO

RREESSEETT

CCLLEEAARR

UUPPGGRRAADDEE

VVEERRSSIIOONN

VVIIDDEEOO

LLAANNGGUUAAGG

RR..EE..TT..RR..

AAUUTTOO

WWAATTEERRMMAA

PPRREE--AALLAARRMM

DDAAYYLLIIGGHHTT
TTIITTLLEE  

DDEETT  

AARREEAA  

LLSS  

SSSS  

TTSS  

RREE  

AALLAARRMM  

DDEETTEECCTTII

TTIITTLLEE  

DDEEVVIICCEE  

IIDD  

PPRROOTTOOCC

RRAATTEE  

DDEETTEECCTTIIOO
NN TTIIMMEERR

MMOONNIITTOORR  
OOUUTT

OOSSDD  
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Record 

 

Manual Record Enable 
Indicates whether the DVR has been manually set to record. If you have pressed the REC button on the front panel to 
start recording, then this will say YES. 
 
You can start or stop recording manually, by changing this value to either YES or NO. 

Event Record Enable 
Sets whether the DVR should start recording when motion is detected or the external alarm is triggered. 
 
For more information on motion detection and external alarms see Advance > Detection 

Timer Record Enable 
Sets whether the DVR should use the timer schedule to start and stop recording. 

Overwrite 
Sets whether the DVR should automatically overwrite the oldest footage when the hard drive becomes full. 

Record IMG Size 
Sets the resolution the DVR will record in. Recording in FRAME mode forces the DVR into MJPEG and will use 
approximately 5 times as much space as CIF mode. 
 
FRAME (MJPEG)  704 x 576 pixels 
CIF (MPEG4)   352 x 288 pixels 

Record Quality 
Sets the quality to record in. It is best to experiment with these settings to find a quality level that suits you. There are four 
options available – BEST, HIGH, NORMAL and BASIC. 
 

 

Manual Record IPS 
Sets how many IPS the DVR will record in when manually set to record by the user. 

Event Record IPS 
Sets how many IPS the DVR will record in when it detects motion or is triggered by an external alarm. 

Timer Record IPS 
Sets how many IPS the DVR will record in when it is recording off the timer schedule. 

Total IPS Share 
This option does not apply to this model DVR. 

Note: The images per second (IPS) settings are global. This means that if you have the IPS set to 100, each camera 
will record at 25 IPS. Likewise, a setting of 12 would have each camera record at 3 IPS. 

    RREECCOORRDD  
     
    MANUAL RECORD ENABLE 
    EVENT RECORD ENABLE 
    TIMER RECORD ENABLE 
    OVERWRITE 
    RECORD IMG SIZE 
    RECORD QUALITY 
    MANUAL RECORD IPS 
    EVENT RECORD IPS 
    TIMER RECORD IPS 
    TOTAL IPS SHARE 
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Timer 

 
 
Using the Timer menu you can setup multiple recording schedules. The DATE specifies what days the schedule applies. 
The START and END times indicate (in 24 hour format) when the DVR will record. 
 

 

Date 

 
 
The Date menu is used to set the date, time and daylight savings settings for the DVR. 
 

 
 
The daylight savings option will tell the DVR to adjust the time during a certain date range. 

 

 
 
Example - In the image above: During the daylight savings time period (starting on the 4th Sunday of March and ending 
on the 4th Sunday of October), the DVR time will run one hour ahead. 

Note: Never change the date and time when the DVR is recording - stop recording before hand. 

    RREECCOORRDD  
     
    DATE START  END 
    OFF  00  :  00    - 00  :  00 
    DAILY 08  :  00    - 18  :  00 
    SUN  06  :  00    - 23  :  00 
    MON-FRI 00  :  00    - 00  :  00 
    OFF  00  :  00    - 00  :  00 
    OFF  00  :  00    - 00  :  00 
    OFF  00  :  00    - 00  :  00 

Note: The DVR will only use the timer schedule if the Record > Timer Record Enable option is set to YES. 

   DDAATTEE  
     
    DATE  2006-MAY-12   16:30:00 
    FORMAT  Y-M-D 
    DAYLIGHT SAVING ON 

    DDAAYYLLIIGGHHTT  SSAAVVIINNGG  
     
    START  4TH-SUN-MAR   01: 00: 00 
    END   4TH-SUN-OCT   01: 00: 00 
    ADJUST  01 : 00 
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Advance 

 

 
Advance > Camera 
Title 
This option allows you to create a name for the camera. 
 
Brightness / Contrast / Saturation / Hue 
This option allows you to modify these four values for the camera. 

Covert 
This option allows you to hide a camera from display. It will still record, but will only show during playback. 

Record 
This option allows you to configure whether to record this camera or leave it as display only. 
 

Advance > Detection 

 

Advance > Detection > Detection Setup 

 

Detection 
This option enables and disables motion detection for this individual camera. 

Area 
Press ENTER to setup area masking for this camera. 
 

Note: The Advance menu of the DVR is enthusiasts or experts only. Changing settings in this section of the menu 
can drastically alter the performance and functionality of the DVR. It is recommended you do not change anything 
in this section unless you know what you are doing.

AADDVVAANNCCEE  
 
                  CAMERA 
                  DETECTION 
                  DISPLAY 
                  ALERT 
                  REMOTE 
                  SYSTEM 
                  NETWORK 
                  HDD INFO 
                  EVENT LOG 

DDEETTEECCTTIIOONN  
    
   DETECTION SETUP 
   DETECTION TIMER 

DDEETTEECCTTIIOONN    
   
 TITLE DET AREA LS SS TS RE ALARM 
  01 ON SETUP 07 03 02 10 OFF 
  02 ON SETUP 07 03 02 10 LOW 
  03 ON SETUP 07 03 02 10 HIGH 
  04 ON SETUP 07 03 02 10 OFF 
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LS 
The sensitivity of comparing two different images. The smaller the value is, the higher sensitivity for motion detection. The 
highest sensitivity setting is 00 and the lowest sensitivity setting is 15. The default value is 07. 

SS 
The sensitivity regarding the size of the triggered object on the screen (the number of motion detection grids). The smaller 
the value, the higher sensitivity for motion detection. The highest sensitivity setting is 00 and the lowest sensitivity setting 
is 15. The default setting is 03. 
 

 

TS 
The sensitivity regarding how long the object gets triggered. The smaller the value, the higher motion detection sensitivity 
will be. The highest sensitivity setting is 00 and the lowest sensitivity setting is 15.  The default setting is 02.  

RE 
The value of RE is a reference for detection. The default value is 10, which means DVR will compare 10 continuous 
images at one time according to the sensitivity of LS, SS, TS simultaneously. The bigger the value, the higher sensitivity 
for motion detection. The highest sensitivity is 61. 

Alarm 
Select LOW / HIGH for the alarm. The default alarm value is OFF. 

Press “ENTER” to confirm the 
start area  

Press ◄ or ► to choose the 
width of the area

Press ▲ or ▼ to choose the 
height of the area, and press 
“ENTER” again to confirm. 

Multi-detection areas Press  “－”  to set the whole 
area under detection

Press  “＋”  to set the whole 
undetected 

Note: The default setting of Spatial Sensitivity is 03, which means once a object  is detected more than 3 grids, the 
system will get triggered. So the value of Spatial Sensitivity must be less than the number of grids that you set up for 
the motion detection area. 
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Advance > Detection > Detection Timer 

 
 
The DVR will only check for alarm inputs or motion when in a scheduled time period. 

Advance > Display 

 

Title Display / Date Display 
Configures whether or not to show camera title and date information on screen. 

HDD Info 
This option configures whether or not to show the current hard drive capacity on screen. 

Loss Screen 
Configures whether to show a BLUE or BLACK screen when video loss is detected. 

Playback Info 
This option configures whether to show playback info in the bottom left (NORMAL) or center (CENTER). 

Dwell Duration 
This option configures how long the DVR should ‘dwell’ on each camera when it is in sequencing mode. 

De-Interlace 
This option configures whether the monitor output is de-interlaced. 

Monitor Out 
This DVR does not support multiple output monitors. Do not change this value. 

OSD 
This sub menu lets you customise the colour values of the on-screen display. 

Watermark 
This option places a security watermark in stored video. It is recommended that you leave this option turned on. 

    DDEETTEECCTTIIOONN  TTIIMMEERR  
     
    DATE START  END 
    OFF  00  :  00    - 00  :  00 
    DAILY 08  :  00    - 18  :  00 
    SUN  06  :  00    - 23  :  00 
    MON-FRI 00  :  00    - 00  :  00 
    OFF  00  :  00    - 00  :  00 
    OFF  00  :  00    - 00  :  00 
    OFF  00  :  00    - 00  :  00 

    DDIISSPPLLAAYY  
     
    TITLE DISPLAY  ON 
    DATE DISPLAY  ON 
    HDD INFO   ON 
    LOSS SCREEN  BLUE 
    PLAYBACK INFO  NORMAL 
    DWELL DURATION (SEC) 2 
    DE-INTERLACE  ON 
    MONITOR OUT  MAIN 
    OSD    SETUP 
    WATERMARK  ON 
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Advance > Alert 

 

External Alert 
Configures whether to sound the buzzer when the external alarm is triggered. 

Internal Buzzer 
Sets the sound of the internal buzzer. 

Key Buzzer 
Configures whether to sound the buzzer when pressing buttons on the front panel. 

Video Loss Buzzer 
Configures whether to sound the buzzer when video loss is detected. 

Motion Buzzer 
Configures whether to sound the buzzer when motion is detected. 

Alarm Buzzer 
Configures whether to sound the buzzer when the internal alarm is triggered. 

HDD Buzzer 
Configures whether to sound the buzzer when the hard drive is full. 

HDD Nearly Full (GB) 
Sets the amount of remaining hard drive capacity required before the alarm will sound. 

Alarm Duration (SEC) 
Sets the amount of time to record once an alarm event has been detected. 

Pre-Alarm 
Sets whether the DVR should record events before an alarm trigger occurs. 
 

    AALLEERRTT  
     
    EXT. ALERT   ON     
    INT. BUZZER  ON 
    KEY BUZZER  ON 
    VLOSS BUZZER  ON 
    MOTION BUZZER  ON 
    ALARM BUZZER  ON 
    HDD BUZZER  ON 
    HDD NEARLY FULL (GB)  05 
    ALARM DURATION (SEC)  05 
    PRE-ALARM   OFF 
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Advance > Remote 

 
 

 

Device 
Configures whether the camera attached to this channel is a NORMAL or PTZ camera. 

ID 
Configures the PTZ ID of the camera. Range of 1 ~ 255. 

Protocol 
Configures the protocol for the camera as either NORMAL or Pelco-D P-D. 

Rate 
Configures the baud rate used by the camera as either 2400, 4800, 9600, 19200, 57600. 

Connection Guide 
Connect “RS485-A” line (brown colour) to RS485-A port on the rear panel of the DVR. 
Connect “RS485-B” line (orange colour) to RS485-B port on the rear panel of the DVR. 
 
 
 

 
 

RREEMMOOTTEE  
  
 TITLE DEVICE ID PROTOCOL  RATE 
  01 PTZ  001 P - D   02400 
  02 CAMERA 002 NORMAL  02400 
  03 CAMERA 003 NORMAL  02400 
  04 CAMERA 004 NORMAL  02400 

Note: This section of the menu is for configuring the DVR to send PTZ commands to cameras. Please note that the 
cameras supplied with this DVR do not support this feature. 
 
If you wish to use a PTZ camera with this DVR, the camera must support the Pelco-D protocol. 
 
For more information on setting up a PTZ camera, refer to your cameras manual.
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Advance > System 

 

Serial Type 
Switches the serial type of the DVR between RS-232 and RS-485. 

Baud Rate 
Switches the baud rate of the DVR between 2400, 9600, 19200 and 57600. 

Host ID 
Sets the ID of the DVR. Range of 1 ~ 255. 

Password 
Modifies the admin and guest passwords for the machine. 

Reset Default 
Resets the system to the factory default setting.  
 

 

Clear HDD 
Erases all recorded footage off the hard drive. 

Auto Keylock 
Configures the DVR to automatically turn the keylock on after 10, 30 or 60 seconds. Set to NEVER to disable this feature. 

Language 
Configures the language of the on-screen display. 

Version 
The current firmware version of the DVR. 

Video Format 
This option switches the video format between PAL and NTSC. Australia uses the PAL system. 

Note: Your DVR has been pre-configured to record for 4 weeks. This is not the factory default setting. 

     SSYYSSTTEEMM 
     
   SERIAL TYPE  RS - 485 
    BAUD RATE   02400 
    HOST ID   003 
    PASSWORD   SETUP 
    RESET DEFAULT  RESET 
    CLEAR HDD   MASTER 
    AUTO KEYLOCK  NEVER 
    LANGUAGE   ENGLISH 
    VERSION   1088-10-K2-04-AA-11 
    VIDEO FORMAT  NTSC 
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Advance > Network 

 
 

 

Network Type 
Configures whether the DVR uses a Static IP, DHCP or PPPoE network connection. 
 
After choosing which type of connection to use, press the ENTER button to enter the relevant information for each type. 

DNS 
Set the DNS server for the DVR. 

Port 
Set the Port that the DVR should run on. Default is 80. 

Advance > HDD Info 
This section of the menu shows you the remaining capacity of the internal hard drive. 
 

 

Advance > Event Log 
This section of the menu allows you to view lists of system events, such as video loss, network access, etc. 
 

 
 

Note: If you do not have a thorough understanding of TCP / IP technology it is recommended that you employ the 
services of a network technician to help you. 
 
For more information on setting up the remote connection component, please see Section 3 of this manual. 

     NNEETTWWOORRKK  
     
    NETWORK TYPE  STATIC  
    DNS                203 . 021 . 020 . 020 
    PORT   0080  

HHDDDD  IINNFFOO  
   
 HDD NUM HDD SIZE HDD NUM HDD SIZE 
 MASTER-1 080.000  SLAVE-1 NO HDD 
 MASTER-2 NO HDD SLAVE-2 NO HDD 
  EXT001 NO HDD EXT 002 NO HDD 
  EXT003 NO HDD EXT 004 NO HDD 
  EXT005 NO HDD EXT 006 NO HDD 
  EXT007 NO HDD EXT 008 NO HDD 
  EXT009 NO HDD EXT 010 NO HDD 
  EXT011 NO HDD EXT 012 NO HDD 

EEVVEENNTT  LLOOGG  
   
 VLOSS  LIST 
 NET   LIST 
 SYSTEM  LOG 
 OTHERS   
 CLEAR  ALL 
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Section 2 – Network Operation 

Introduction 
There are two ways you can remotely connect to your DVR. 
 
The first method is to connect using the AP software. This must be installed on your computer.  
 
The second method is to connect using Internet Explorer. 
 
Either method requires that Windows networking has been set up correctly for the DVR prior to connection.  Refer to the 
Microsoft Windows documentation or contact an IT Professional for more information. 
 

Default DVR Network settings 
 
Username:  admin 
Password:  admin 
IP Address:  192.168.0.1 
Port:  80  

Connecting via AP Software 

Install AP Software 
You can obtain the AP software from the supplied CD-ROM or by browsing to 
http://www.watchguardalarms.com.au/dvr4entpack.php and following the directions on the page. 
 
Note: Refer to page 14 on information regarding checking / altering the DVR’s network settings. 

AP Software – Login Screen 

Login Exit

Port 

Username 

Password 

IP Address 

Search for DVR

DVR List

Open Backed Up footage

Upgrade Firmware 

Copy AP Software Settings
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b i a c e f g h d

j. 

 

AP Software – Camera Screen 
The AP software works by emulating the buttons on the front panel of the DVR. Anything you can do on the DVR can also 
be done in the AP software. 
 
a) Frame Rate 
 
b) Data Rate (bandwidth being used) 
 
c) Connect / Disconnect from DVR 
 
d) Switch display resolution between 320 x 276 and 640 x 552. 
 
e) Image Quality (High, Medium, Low) 
 
f) Take a Snapshot. Saved in the location set in System Config > General > File Path > Snapshot Path. 
 
g) Start and stop recording. Saved in the location set in System Config >General > File Path > Record Path. 

This will record what you see on screen to your own computer. 
 
h) Open the System Config menu. 
 
i) The number of users connected to the DVR. 
 
j) Theses buttons all emulate the front panel of the DVR. Please refer to the quick installation guide and the menu 
section above. Hover your mouse cursor over the button to get a description of what it does. 
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Playback Operation 

 

•  PPllaayybbaacckk  IInnffoorrmmaattiioonn  : 
Display information such as “Date”, 
“Time”, “Resolution”, “ Rewind / 
Forward Speed”, “Status” and 
“Functions”, etc.  

•  TTiimmee  PPrrooggrreessss  BBaarr  : 
Show the playback progress status. 

•  FFuunnccttiioonnss  : 
 
 
 
 
 
 
 
 
 
 
 
 
 

•  PPllaayybbaacckk  CCoonnttrrooll  BBuuttttoonnss  : 
Play / Stop / Pause / Fast Rewind / 
Fast Forward 

•  SSnnaappsshhoott  : 
Press this button to take a snapshot of 
the current image which will be saved 
in the designated destination. 

•  CClloossee  tthhee  PPllaayyeerr 

  De-interlace: Reduce the vibration of the paused picture. 
  De-blocking: Reduce the video mosaic phenomenon. 
  OSD: Display the OSD of the AP playback window. 
  AVI conversion: Convert the entire recorded file to the AVI format. 
  Config. Setting: Enter the AP config. setting box, and 
 set the file path, text color and text color of progress status. 
 * MMuuttee: Play back the video only (without audio). 
 * AAVV  SSyynncc..: Play back with the audio and video synchronously.  

  Watermark: Proof the authenticity of the backup video. 
  Open Previous File: Open the previous backup video. 
  Open Next File: Open  the next backup video. 

OOnnee cclliicckk  ttoo  aaccttiivvaattee  

• De-interlace 
• De-blocking 
• OSD 
• AVI Convert 
• Config. Setting 
• Watermark 
• Open Previous File 
• Open Next File 

NNoottee::  
• When users pause the playback picture, press 

“             ” button to go to the previous frame, or press 
“             ” button to go to the next frame. 

• In the playback mode of the software AP, users could 
press ”             “ button to check the authenticity of the 
BACKUP VIDEO. If the BACKUP VIDEO had been 
altered, the video image will turn to lliigghhtt  rreedd and the 
playback will be paused. 

NNoottee::  
• When users use remote AP recording, the watermark 

function is not supported. 

To snap a video clip, right click the mouse to make a 
starting point (red) and click one more time to make a 
ending point.  Then right click to convert to the AVI 
format. 

A B C D E F 
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System Config > Network 
 
Press the  button to enter the System Config. 
 

 

The network configuration allows the 
DVR to connect to an Ethernet or 
dial-up network. 

  SSttaattiicc  IIPP::  
Enter the “server IP”, “gateway”, “net 
mask” and “web port”, and then press 
“APPLY” to confirm.  

 PPPPPPOOEE::  
Enter the “username” and “password” 
provided by your ISP (Internet Service 
Provider). Then, go to “DDNS” and 
finish DDNS settings before pressing 
“APPLY”. 

 DDHHCCPP:: 
This DHCP function needs to be 
supported by a router or a cable 
modem network with DHCP services. 
Choose the DHCP IP type. Then, go 
to “DDNS” and finish DDNS settings  
before pressing “APPLY”. 

NNoottee:: 
 PPPOE and DHCP network 
connection types are required to apply 
DDDDNNSS  sseerrvviicceess FIRST to get a 
“HHoossttnnaammee” to correspond to the 
dynamic IP address 

 Some router brands may need to 
restart the DVR to get the IP address. 

 WWeebb  PPoorrtt:: 
The DVR can be viewed over the 
network with the software AP or a web 
browser. Typically, the TCP port used 
by HTTP is 80. However in some 
cases, it is better to change this port 
number for added flexibility or 
security. The valid number ranges 
from 1 to 9999. 
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System Config > Network  > Dynamic DNS 
 

 

System Config > Network > Mail 

 

 DDNS is a service for transforming the 
dynamic IP corresponding to a specific 
“Hostname”. 

  DDDDNNSS  AAppppllyy:: 
Go to a website which provides free 
DDNS services and apply a “Hostname”. 
See the example below. 

  EEnnaabbllee  tthhee  DDDDNNSS  ffuunnccttiioonn: 
User Name: Enter your DDNS user name. 
Password: Enter your DDNS password.  
Domain: Enter your host name. 
System Name: Choose the DDNS system 
name you use from the drop-down list.  

 After setting, press “APPLY” to confirm. 
 NNoottee:: If the dial-up static IP is provided by your ISP, simply choose “Enable” and do not  

          need to enter the information described above. 
  AAuuttoo:: 

When using DHCP network connection, the "AUTO" check box will appear on this window. 
The system will automatically get DNS information from the Internet if this check box is 
selected. 

 When the recording is triggered by 
an alarm or a motion, a video copy 
file can be captured. The DVR will 
send an e-mail notification to the 
assigned recipients (up to 5 
recipients).  
******NNoottee******:: 
To activate the e-mail notification 
function, please enable the function 
of e-mail notification in the “Alarm” 
setting first (page 26). 

 Add the recipients’ email accounts 
in “Mail Account” column.  
 

       For detailed information (SMTP server, username and password), please get 
from your e-mail system supplier. 

 Please type the entire email address in the “Mail from” column to ensure emails 
will not be blocked by SMTP. 

 In some cases, mail servers require to verify password. Please enter the “user 
name” and “password”. 

 After finishing the settings, press “APPLY” to confirm. 
 

4CH DVR
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System Config > Network > FTP 
 

 
 

System Config > DVR 
 

 
 

System Config > Device 

 

 When the recording is triggered by an 
alarm or a motion, a video copy file 
can be captured. And the DVR will 
upload the captured images to the 
assigned FTP site. 

 Enter the detailed FTP information. 
         ******NNoottee******:: 

To activate the FTP notification 
function, please enable the function 
of FTP notification in the “Alarm” 
setting first. (Refer to Pg 26). 

 After setting, press “APPLY” to 
confirm. 

4CH DVR

 Each camera channel can be adjusted 
independently. 

 Select the desired camera channel. Press 
“EEddiitt” to enter the setting box. 

  TTiittllee:: 
Enter the camera channel name up to 6 
characters. 

  AAddjjuussttmmeenntt:: 
Adjust the BR (brightness) / CT (contrast) / 
SU (saturation) / HU (hue) / REC (recording) 
of the camera. 

 After setting, press “OK” and then press 
“APPLY” to confirm. 

 Select the desired channel of the installed 
external device. 
Press “EEddiitt” to enter the setting box. 

  DDeevviiccee  TTyyppee: 
Choose either general camera or PTZ 
camera. 

  IIDD  NNoo.. : 
Set the ID number (0 ~ 255) of the installed 
external PTZ device. 

  PPrroottooccooll  TTyyppee : 
Choose “NNOORRMMAALL” protocol for our own 
brand camera. 
Choose “PP--DD” protocol for PELCO-D 
protocol camera. 

  BBaauudd  RRaattee : 
Set the baud rate of each channel  
(2400, 4800, 9600, 19200, 38400, 57600, 
115200). 

 After setting, press “OK” and then press 
“APPLY” to confirm. 
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System Config > Detection 
 

 

 Select the desired channel, and 
press “EEddiitt” to enter the motion 
detection sensitivity and area 
setting box. 

  MMoottiioonn  DDeetteeccttiioonn  SSeennssiittiivviittyy: 
Set the detection sensitivity in 4 
different adjustable factors.  
LLSS:: The sensitivity of comparing 
two different images. The smaller 
the value, the higher sensitivity for 
the motion detection.  
SSSS:: The sensitivity towards the 
size of the triggered object on the 
screen (the number of motion 
detection grids). The smaller the 
value, the higher sensitivity for the 
motion detection.  
TTSS:: The sensitivity towards how 
long the object stays in the 
detection area to get triggered. 
The smaller the value, the higher 
sensitivity for the motion detection.  
RREE:: The value of RE is a reference 
for the detection. The bigger the 
value, the higher sensitivity for the 
motion detection. 

  AAllaarrmm:: 
Select LOW / HIGH for the alarm 
polarity.  

  MMoottiioonn  DDeetteeccttiioonn  AArreeaa: 
By clicking the area with your 
mouse, one can choose the 
motion area to be detected. TThhee  
uunnddeerr  ddeetteecctteedd  aarreeaa  iiss  ttrraannssppaarreenntt  
wwhhiillee  tthhee  uunnddeetteecctteedd  aarreeaa  iiss  iinn  
ppiinnkk  ccoolloorr.. 
*Click “Select All” to activate the 
detection area as the full area.  
*Click “Clear All” to clean the 
previously selected detection area. 
After setting, press “OK” and then 
press “APPLY” to confirm. 
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System Config > DVR > Network Backup 
 

 
 

Making backup to your PC:  
After pressing “Start”, the backup will begin 
and a status bar will be displayed. 
 
The  “DVR Network Backup” pop-up 
window will show the message “Download 
process is finished” when the backup has 
succeeded.  
 
Press “PLAY” button to directly convert and 
play the file, or “Exit” to quit. 
 
To convert the backup file later, please find 
the file in the designated file path and 
double-click it twice for AVI conversion and 
file playback. 
 

1. Enter the backup information:  
If you want to make a backup to a CD, 
please check “Copy to CD”. 
If you want to view the backup image while 
the backup is processing, please check 
“Dynamic Download”. 

2. Press "Start" button to proceed the 
backup process.  

You can backup the recorded data from the DVR directly to your PC and CD-R disk via 
the network. The backup file can be played directly in your PC via the supplied licensed 
AP, or via other media players (Ex: Windows Media Player or RealPlayer) after the file 
is converted to “AVI” format.  
NOTE: For CD backup, please install “NERO” CD burning program to your PC first. 
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System Config > DVR > Search List 
 

 
 

System Config > DVR > Timer Record 
 

 
 

  HHDDDD  NNuummbbeerr:  
Select one HDD (Master). 

  LLiisstt  TTyyppee:  
Select one list type (All/ Manual/ 
System/ Alarm/ Motion). 

  MMaaxx  LLiisstt  NNuummbbeerr:  
Maximum number of the list (128) 

  DDoowwnnllooaadd  HHDDDD  LLiisstt:  
Press this button to start 
downloading the list. 

4CH DVR

  DDAATTEE:  
Choose a day from “DATE” drop-
down menu. The options are OFF, 
SUN, MON,TUE, WED, THU, FRI, 
SAT, MON-FRI, SAT-SUN and  
DAILY. 

  SSTTAARRTT:  
Enter the start time of timer recording. 

  EENNDD:  
Enter the end time of timer recording. 

In this menu, you can schedule 7 
different sets of time for recording. 

Press “APPLY” if the settings are correct; press “EXIT” to quit without 
saving. 

4CH DVR
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System Config > DVR > Date 
 

 
 

System Config > DVR > Record Setting 
 

 
 

In this menu, The DVR’s date can be set.  Please DO NOT change the date or time when 
the recording function is activated.  

  DDAATTEE:  
Choose the current date from 
“DATE” drop-down menu and enter 
the current time.  

 When you click the drop-down 
menu, a calendar as shown below 
shows for you to set the current 
date. 

  FFOORRMMAATT:  
Choose the format for date display from the three options: Y-M-D, D-M-Y and M-D-Y. 

  DDAAYYLLIIGGHHTT  SSAAVVIINNGG:  
Specify whether to use daylight saving time (ON / OFF) and time period (START / 
END), and adjust the daylight saving time in hour (ADJUST). 

4CH DVR

  MMAANNUUAALL  RREECCOORRDD:  
Specify whether to use manual 
recording (YES / ON) and set IPS 
number. 

  EEVVEENNTT  RREECCOORRDD:  
Specify whether to user event 
recording (YES / ON) and set IPS 
number. 

  TTIIMMEERR  RREECCOORRDD:  
Specify whether to use timer 
recording (YES / ON) and set IPS 
number. 

  OOVVEERR  WWRRIITTEE: 
Specify whether to overwrite the  
HDD capacity when the HDD is full 
(YES / NO). 

  RREECCOORRDD  IIMMGG  SSIIZZEE:  
Choose “FRAME” or “CIF”. This 
selection will affect the available IPS 
options in the 3 recording modes 
described above. 

  RREECCOORRDD  QQUUAALLIITTYY:  
4 options are available from the 
drop-down menu: BEST, HIGH, 
NORMAL and BASIC. 

  TTOOTTAALL  IIPPSS  SSHHAARREE: 
Choose the IPS share as FIX or 
GROUP. 

4CH DVR

In this menu, you can set DVR record settings.   
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System Config > Alarm 
 

 
 

System Config > General 
 

 
 

4CH DVR
NNoottee::  
Email Notification: 
MJPEG pictures will be made at your designated space set in “File 
Path”, plus an e-mail contained with the MJPEG pictures (1-10 
pictures) to be sent to the address which is set under “Mail”. 
FTP Notification: 
MJPEG pictures will be made at your designated space set in “File 
Path”, plus a FTP file contained with the MJPEG pictures (1-10 
pictures) to be sent to the address which is set under “FTP”.  

  AAllaarrmm  TTrriiggggeerr:  
Enable or disable Email and FTP notification 
function. 

  AAllaarrmm  MMeetthhoodd:  
Two notification methods 
— Email and / or FTP. 

  PPoosstt  NNuummbbeerrss:  
Set MJPEG pictures (1-10 pictures). 

  AAllaarrmm  DDuurraattiioonn:  
Set the duration time of motion trigger recording 
(5 SEC, 10 SEC, 20 SEC, 40 SEC). 

  AAllaarrmm  RReeffrreesshh:  
Clean the alarm message “     ” which is shown 
on the screen.  

 Get the information of the DVR firmware version 
in this window. 

  SSeelleecctt  ““TTUURRBBOO””  SStteepp””  ((11  --  1100)) 
To speed up menu selection or the control of the 
PTZ camera under video web servers, users can 
activate "TURBO" function by clicking this 
button. Users are allowed to change the turbo 
steps from 1 to 10.   
Ex: If the value of turbo step is “5“, it means that 
when users press one of the button 
up/down/left/right, one click is as clicking 5 
times. 

  MMAAXX  LLOOGG  LLIISSTT: 
Set the maximum number of log list. 

  SSeerrvveerr  LLoogg: 
Press “Server Log” button to enter the server log 
list window. 

  TTiittllee  TTiittllee: 
Name the title which will be shown on the top of 
the AP live viewer (up to 15 characters). 
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System Config > General > Account 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Set up the user’s account (Max 5 
accounts), password, life time, and 
authority level (MMaaxx  55  uusseerrss  oonn  lliinnee  aatt  tthhee  
ssaammee  ttiimmee).  

 User’s level:  
SSUUPPEERRVVIISSOORR    —— 
Control all the functions  
(“a”, “b”, “c”, “d”, “e” and “f” ).  
HHIIGGHH    ——  
Control only “a”, “b”, “c”, “d” and “e” 
functions, but cannot control “f” function.  
NNOORRMMAALL    ——  
Control only “a”, “d”, and “e” functions, but 
cannot control “b”, “c” and “f” functions.  
GGUUEESSTT    ——  
Watch the image only. Only “a” function 
can be used. 

  LLiiffee  ttiimmee :  
According to different authority levels, 
different accounts can stay online for 
different time periods (1 Min, 5 Min,  
10 Min, 1 Hour, 1 Day, INFINITY). 

a b c d e f 
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System Config > General > Online User Info 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

System Config > General > File Path 
 
 
 
  

 Get all the current online users’ information 
list (Name, IP Address, Authority Level, 
Resolution and Image Quality). 

  SSnnaappsshhoott  PPaatthh: 
Assign the route for saving the snapshot picture. 

  RReeccoorrdd  PPaatthh: 
Assign the route for saving the manually recorded 
file. 
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Troubleshooting 
 
PROBLEM SOLUTION 

Check power cord connection. No power 
Confirm that there is power from the outlet. 

Not working when pressing 
any button 

Press any key and then enter the password to exit “Key Lock” mode. 

Timer record is not working Check if the “TIMER RECORD ENABLE” is set to “YES”. 
Check the camera’s video cable and connections. 
Check the monitor’s video cable and connections. 
Confirm the camera is power supplied. 

No live video 

Check the setting of the camera lens. 
No recorded video Check if the HDD is installed and connected properly. 
DVR keeps rebooting Make sure the power connector and HDD are connected closely, or change another 

suitable HDD. 
Change another HDD for testing. 
Change another HDD cable for testing. 

HDD detection failed 

Make sure HDD “Master”, “Slave”  mode is correctly set. 
Can’t detect your USB flash 
drive 

Change another USB flash drive to test. 

Can’t view the DVR images 
over the network with IE web 
browser 

Update the JAVA program. 
Update the firmware of the software AP. 

Can’t play the recorded data 
on my DVR  

There must be at least 8192 images of recorded data for playback to work properly. If not, 
your DVR will stop the playback.  
For example, if the IPS is set to 30, the recording time should be at least 273 seconds 
(8192 images / 30 IPS) for the playback to work properly. 

Error Code in “SYSTEM LOG”:                                                              Meaning: 
 
1) SYS ERR 01-YYY #define SYS_ERR_AV087_ERR                Compression error 
                      YYY=000                                                                          Audio chip error 
                      YYY=001- AV087                                                             Chip for CH1-4 error 
                      YYY=002- AV087                                                             Chip for CH5-8 error 
                      YYY=004- AV087                                                             Chip for CH9-12 error 
                      YYY=008- AV087                                                             Chip for CH13-16 error 
                      YYY=003(001+002)                                                          Chips for CH1-4 & CH5-8 error, etc  
2) SYS ERR 02-XXX #define SYS_ERR_AV087_BUF_FULL               Buffer is full 
3) SYS ERR 03-XXX #define SYS_ERR_AV087_BUF_EMPTY           Buffer is empty 
4) SYS ERR 04-XXX #define SYS_ERR_IDE_ERR                              IDE interface error 
5) SYS ERR 05-XXX #define SYS_ERR_SCAN_DISK                         Disk scanning error 
6) SYS ERR 06-XXX #define SYS_ERR_TOP_FAT_ERR                    File system error 
7) SYS ERR 07 (including 08, 09, etc.)-XXX #define                             HDD error 
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Connecting via Internet Explorer 

Install Java Runtime Environment 
Before you can view your DVR in Internet Explorer you must have the Java Runtime Environment installed. This is 
supplied on the included CD. 
 
To install the Java Runtime Environment: 

 Insert the included CD into a computer running Windows 2000 or later. 
 Open the Start menu and press Run. 
 In the Open box type D:\Java.exe and press OK. 
 Follow the on screen prompts to install the Java Runtime Environment. 

 

  
 

  

Connecting to the DVR 
To log into the DVR you need to type the following address into Internet Explorer: 
 
http://<ip-address>:<port> 
 
You will need to replace the <ip-address> and <port> with the values from the Advance > Network section of the menu. 
For example using the default values, the address would be: 
 
http://192.168.0.1:80 
 
The following screen will then show. You can now login using the administrator account. The default username and 
password are admin and admin. 
 

 

Note: Replace D with the letter of your CD or DVD drive. 
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Internet Explorer Operation 
Using the core elements of DVR in Internet Explorer is very similar to using the AP software.  For further information, 
please refer to the AP software instructions 
 

SSaammee  aass  tthhee  AAPP  ssooffttwwaarree  
ooppeerraattiioonn..  
  

CChhaannggee  IImmaaggee  QQuuaalliittyy  

CChhaannggee  RReessoolluuttiioonn  

PPTTZZ  

SSeettss  tthhee  ddiissppllaayy  ppoossiittiioonn  ooff  tthhee    iimmaaggee  
  ((LLTT::  UUppppeerr  LLeefftt;;  LLDD::  LLoowweerr  LLeefftt;;  RRTT::  UUppppeerr  RRiigghhtt;;  LLoowweerr  RRiigghhtt))  
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Pin Configuration 
 
PIN FUNCTION DESCRIPTION 
1 RS232-TX DVR can be controlled remotely by the keyboard of PC by using RS-232 serial 

communication signals. 
2 RS232-RX DVR can be controlled remotely by the keyboard of PC by using RS-232 serial 

communication signals. 
3~6 ALARM INPUT To connect the wire from ALARM INPUT ( PIN 3 -- 6 ) to GND ( PIN 9 ) connector, 

DVR will start recording and the buzzer will be on.  
When “MENU -> CAMERA -> ALARM” is set to “Low” : When the alarm input 
signal is “ Low ”, the unit starts to record and buzzer. 
When “MENU -> CAMERA -> ALARM” is set to “High” : When the alarm input 
signal is “ High ”, the unit starts to record and buzzer.  

7 EXTERNAL ALARM NC Under the normal operation, COM connects with NC and disconnects from NO. 
But when any alarm is triggered, COM disconnects with NC and connects with 
NO. 
Attention: The voltage restriction is under AV/DC 30V.  

8 EXTERNAL ALARM 
NO. 

Under the normal operation, COM disconnects with NO. But when any alarm is 
triggered, COM connects with NO.  
Attention: The voltage restriction is under AV/DC 30V. 

9 GND Signal GND. 
10 RS485-B DVR can be controlled remotely by the keyboard of PC by using RS-485 serial 

communication signals. 
11 RS485-A DVR can be controlled remotely by the keyboard of PC by using RS-485 serial 

communication signals. 
12~13 PIN OFF   
14 ALARM RESET Connecting the wire from ALARM RESET (PIN 14) to GND (PIN 9) connector will 

disable alarms. An external signal to ALARM RESET (PIN 14) can be used to 
reset both ALARM OUTPUT signal and DVR’s internal buzzer. When any alarm 
has been triggered, the signal becomes “Low”, and all alarm activities will be 
stopped. Under the normal operation, the signal remains “High”. 

15 EXTERNAL ALARM 
COM 

Under the normal operation, COM disconnects with NO. But when any alarm is 
triggered, COM connects with NO.  
Attention: The voltage restriction is under AV/DC 30V. 

16~17 GND Earth GND 
 
 
 
 
 
 
 

DC12V +

GND

8  7  6  5  4  3  2  1

15 14 13 12 11 10  9
16                    17

PIN Connection Application

Solder Side 
of DSUB 

15PIN

DC12V +

GND

DC12V +

GND

8  7  6  5  4  3  2  1

15 14 13 12 11 10  9
16                    17

8  7  6  5  4  3  2  1

15 14 13 12 11 10  9
16                    17

PIN Connection Application

Solder Side 
of DSUB 

15PIN

When the magnetic contact is opened, the 
alarm will be triggered and the recording is 
on. At the same time, COM connects with 
NO and the siren with strobe starts wailing 
and flashing.

NOTE: Please go to MENU -> ADVANCE -> 
DETECTION -> DETECTION SETUP, and 
set ALARM to LOW on the local machine.

When the magnetic contact is opened, the 
alarm will be triggered and the recording is 
on. At the same time, COM connects with 
NO and the siren with strobe starts wailing 
and flashing.

NOTE: Please go to MENU -> ADVANCE -> 
DETECTION -> DETECTION SETUP, and 
set ALARM to LOW on the local machine.
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RS-232 Protocol 
 

• Use PC keyboards to simulate DVR keypads. 
• Data: REMOTE PROTOCOL use 8 bit data, 1 start bit, 1 stop bit. 

    ACT                      C0H                           ID                     FUNCTION                    STOP     
   (FFH)                         (7FH) 

w 0x77 KEY_PTZ_WIPER a 0x61 KEY_4 CUT 

    b 0x62 KEY_9 CUT 

G 0x47 KEY_CH16 p 0x70 KEY_PTZ_MODE 

j 0x6a KEY_EJECT_DVD q 0x71 KEY_PTZ_PRESET 

g 0x67 KEY_IRIS_NEAR i 0x69 KEY_PTZ_ZOOM_IN 

h 0x68 KEY_IRIS_FAR f 0x66 KEY_PTZ_ZOOM_OUT 

l 0x6c KEY_PTZ_LIGHT o 0x6f KEY_MODE 

    c 0x63 KEY_16 CUT 

    n 0x6e KEY_SET_CHANNEL 

F 0x46 KEY_CH15 S 0x73 KEY_SEARCH 

E 0x45 KEY_CH14 d 0x64 KEY_AUDIO 

D 0x44 KEY_CH13 K 0x4B KEY_KEY LOCK 

C 0x43 KEY_CH12 z 0x5A KEY_ZOOM 

B 0x42 KEY_CH11 S 0x53 KEY_SLOW 

A 0x41 KEY_CH10 P 0x50 KEY_PLAY 

9 0x39 KEY_CH9 r 0x72 KEY_REC 

8 0x38 KEY_CH8 W 0x57 KEY_POWER 

7 0x37 KEY_CH7 R 0x52 KEY_RIGHT 

6 0x36 KEY_CH6 L 0x4C KEY_LEFT 

5 0x35 KEY_CH5 N 0x4E KEY_DOWN 

4 0x34 KEY_CH4 U 0x55 KEY_UP 

3 0x33 KEY_CH3 m 0x6d KEY_MINUS 

2 0x32 KEY_CH2 k 0x6b KEY_PLUS 

1 0x31 KEY_CH1 ENTER 0x0D KEY_ENTER 

e 0x65 KEY_DWELL M 0x4D KEY_MENU 

ASCII CODE FUNCTION ASCII CODE FUNCTION 
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 Hard Drive Installation 
 
Unscrew the two screws respectively on the two sides of the upper cover. 
Unscrew the four screws on the back side of the upper cover. 
 

 
 
Make sure your hard drive is set to Master. Refer to the hard drive manufacturer’s website if you are unsure. 
 
Mount the hard drive in the internal bracket and attached the power and data cables. 
 

Fig. 1 Fig. 2 Fig. 3 Fig. 4 Fig. 5Fig. 1 Fig. 2 Fig. 3 Fig. 4 Fig. 5
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Section 3 - Remote Setup Guide 

Introduction 
 

 
 

General Connection Information 
By default, the DVR requires port 80 forwarded to 192.168.0.1. This will allow both the AP software and the web browser 
applet to traverse the NAT.   Both the IP and the port number can be configured from Menu > Advance > Network on 
the DVR - Refer to page 14 for more information. 
 

Configuration of a D-link DSL504T (v2) for use with the DVR  
In order to make it easier for end users to setup remote viewing, we have included the following guide for setting up your 
DVR with a D-link DSL-504T ADSL Router. 
 
If you do not currently have an internet connection or modem/router, and plan to use the remote viewing functions, we 
strongly suggest you purchase the above model. 

Initial Router Setup 
The DSL-504T comes with a Quick Installation Guide which should guide you through physically connecting the router as 
well as inputting your own internet connection details (such as your username and password). 
 
Once you have successfully connected the router to the internet (i.e. you can browse to websites) move onto the next 
step. If you can’t get your computer to connect to the internet then please contact D-link or your Internet Service Provider 
(ISP). 

Dynamic DNS 
In order for you to connect to the DVR from a remote site, you will need to know the IP address of your router. There are 
two types of IP address: 
 
Static IP – Your internet connection may come with a static IP address which never changes. To find out if this is the 
case you will need to contact your internet service provider (ISP). If you do have a static IP you can skip to the next 
section, DVR IP Address. Make sure you write down your static IP for future reference. 
 
Dynamic IP – If you don’t have a static IP then your address is said to be dynamic. This means that it will change from 
time to time. To get around this issue you can sign up for what is known as a Dynamic DNS. 
 
By using a Dynamic DNS, you create a user-friendly name that gets updated every time the IP address changes. To do 
this an account must be set up with DynDNS.com, with the account information then entered into the router.   
 
Go to http://www.dyndns.com and click Create Account in the upper right of the window. 
 
Follow the prompts and fill out the create account form. You will shortly receive an email instructing you on how to 
activate your account.  

This guide covers how to use the remote connection functionality of your DVR in a local area network (LAN). 
 
In order to connect to your DVR over the internet you will need to configure your internet connection (i.e. a modem 
or router) to allow incoming connections. 
 
Due to the wide range of hardware and network configurations available, it isn’t possible to provide a complete guide 
on this procedure. 
 
We strongly recommend you speak to an IT professional, such as your Internet Service Provider (ISP) or a 
network technician to help you set this up. 
 
The section below titled General Connection Information should provide enough information for an IT professional to 
configure your equipment, 
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Once you have activated your account, log into the http://www.dyndns.org website using the username and password 
you have created. 
 
From the menu on the left: 

 Click My Services 
 Click My Hosts 
 Click Dynamic DNS 

 
From the page that loads: 

 Click Add Host 
 
From the form that loads: 

 Enter the a memorable name as the Hostname 
 Select an appropriate Domain Name from the drop down list. 
 Click Add Host to submit the form 

 
Once the next page loads, log out of the website. 
 
Log into the router and click on Dynamic DNS menu item. 

 Change the DDNS Server to www.dyndns.org 
 Enter the details for the Username, Password and Host Name as per the DynDNS account you created. 

 
Save the settings: 

 Click Apply 
 Click the Tools tab 
 Click the System menu item 
 Click the Save and Reboot button and select OK when prompted to continue.   

 

 
 

DVR IP Address 
Following the instructions in page 14 of the manual, go to the Advance > Network section of the DVR menu, select static 
and enter the following: 

- IP address  :10.1.1.50 
- Subnet  :255.0.0.0 
- Gateway : Your routers IP address (Default : 10.1.1.1) 

LAN Clients 
Log into the router and click on the Advanced tab:  

 Click on the LAN Clients menu item 
 In the IP Address field enter 10.1.1.50 
 In the Host Name field enter DVR 
 Press the Add button 
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Port Forwarding 
Log into the router and click on the Advanced tab: 

 Click on the Virtual Server menu item 
 From the LAN IP drop down list make sure 10.1.1.50 is selected 
 Select the User check box from the Category list on the left and wait for the page to reload 
 Press the Add button in the bottom left 

 

 
 
When the page loads: 

 Set the DVR as the Rule Name 
 Set the Protocol to TCP, UDP 
 Set the Port Start, Port End and Port Map to 80 
 Press the Apply button. 

 

 
Once the page reloads: 

 Click on the Virtual Server menu item 
 From the LAN IP drop down list make sure 10.1.1.50 is selected 
 Select the User check box from the Category list on the left and wait for the page to reload 
 Select the DVR item from the Available Rules and press the Add> button to the right of the Available Rules list. 

 
Once the page reloads: 

 You should now have the DVR item in the Applied Rules list. 
 Click the Tools tab 
 Click the System menu item 
 Click the Save and Reboot button 

Connecting Remotely 
Note: If connecting from the local network, you MUST use the internal IP address (eg 10.1.1.50).   For more information 
on connecting using Internet explorer, see page 29.   
 
You should now be able to remotely access your DVR. If you have a static IP you should type this into your web browser: 
http://<static-ip>/  (replace <static-ip> with the actual number) 
 
If you have a Dynamic DNS type this into your web browser: 
http://<dynamic-dns>/  (replace <dynamic-dns> with your full hostname – e.g. mydvr.dyndns.org) 
 
When you are connecting using the AP software, enter either you static IP address or your dynamic DNS as the IP 
Address. 


